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Introduction
Libero® SoC software offers high productivity, with comprehensive, easy-to-learn, easy-to-adopt development tools
for designing with Microchip's PolarFire® SoC, IGLOO® 2, SmartFusion® 2, RTG4® SmartFusion®, IGLOO®,
ProASIC® 3, and Fusion families.

To download the latest Libero SoC software, visit www.microchip.com/en-us/products/fpgas-and-plds/fpga-and-soc-
design-tools/fpga/libero-software-later-versions#downloads.

A license is required to run the Libero SoC software. To select the appropriate license, visit the Licensing web page
and download the Libero License Selector Guide.

This guide describes how to download and install the Libero SoC software and the prerequisites needed to run the
application on your system. It also describes how to obtain and install licenses on your system.

Note: In this document, the term “Libero” refers to the Libero SoC Design Suite.

Important: 
This document is updated frequently. The latest version of this document is available at this location:
Libero SoC Design Suite Documentation.
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1. Libero SoC Software Installation and Configuration
This section explains how to install and configure the Libero SoC Design Suite.

1.1 System Requirements
You must meet all system requirements to install the Libero SoC software on your system.

For more information about product families, platforms, and details about current system requirements, visit the
Libero SoC Requirements page.

Important: Libero SoC supports 64-bit Windows® and Linux® operating systems only.

1.2 Logging In
You need a Microchip portal login account to download the required Libero Design Suite and licenses. To log in:

1. Open the Microchip Portal in a browser. The sign in page appears.
2. If you are an existing user, enter the credentials in the required fields. Otherwise, click Register for an

account to register for a new account.
3. Click Sign In.

1.3 Downloading the Libero SoC Software
You must have Admin rights on the installation machine to install the Libero SoC software.

To run the Libero SoC software on your system, download the software from the Libero SoC Software page.

1. Visit the Libero SoC Software page. The Libero SoC Design Suite Versions 2022.1 to 12.0 page appears.
2. Go to the Latest Software tab and click the latest Libero SoC software download link. The download page

appears.
3. Download the Libero SoC software to your system.

1.4 Installing the Libero SoC Software
You can install the Libero SoC Software on your system for Windows or Linux.

Note: You must have Administrator rights on Windows to install the Libero SoC Software.

1.4.1 Installing the Libero SoC Software on Windows
Install the Libero SoC Software from a DVD or over the web.

Important: If you have a USB Hardware Key Dongle license, DO NOT attach the USB dongle prior to
installing Libero or USB drivers. The USB dongle must be attached after the software and USB driver
installation. See "Installing a Node-Locked USB Dongle License on Windows" regarding USB Driver
installation.
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1.4.1.1 Installing the Software from the Web (Recommended)
Download the Libero SoC for Windows Web Installer from the Download Software page to your local machine. Then
execute the .exe file and select the features you want to install on your local machine. Options are provided for
configuring the features.

To install the Libero SoC Software over the web:

1. Make sure your hard drive has at least 25GB of available disk space.
2. Navigate to the Download Software page.
3. Choose the Windows Web Installer option.
4. Execute the .exe file from the downloaded folder.
5. Follow the prompts to complete the installation.

1.4.1.2 Installing the Software from a DVD (or full ZIP file from the Web)
To install the software from a DVD or full installer:

1. Make sure your hard drive has at least 25 GB of available disk space.
2. Insert the Libero SoC Software DVD or double click the Windows Full Installer ZIP file you downloaded from

the web.
3. Unzip (extract) the ZIP archive.
4. Execute the Libero_SoC <version> shortcut in the extracted folder. When the Libero SoC <version> Install

Anywhere Wizard appears, follow the on-screen instructions.

1.4.2 Installing the Libero SoC Software on Linux
You can install the Libero SoC Software on Linux in GUI or Console mode.

Important: For information about how to setup the Linux environment, see the Libero SoC Linux
Environment Setup User Guide.

1.4.2.1 Installing the Libero SoC Software in GUI Mode (Small Binary Installer)
Perform the following steps to download and install the Libero SoC Software in GUI mode with a small installer binary
(100 MB). With this installer mode, you can save time and storage by selecting different products in the Libero SoC
Software suite to install. This is the default and recommended installation procedure.

Important: Before installing the Libero SoC software, make sure your hard drive has at least 30 GB free
and at least 35 GB in the temp directory during installation.

1. Visit www.microchip.com/en-us/products/fpgas-and-plds/fpga-and-soc-design-tools/fpga/libero-software-later-
versions#downloads.

2. Download Libero_SoC_<version>_Web_lin.zip installer to a temp directory.
3. Change directory to the temp directory.
4. Unzip(extract) the ZIP archive.
5. Launch the Libero SoC installer:

%./launch_installer.sh
6. Launch the Libero SoC installer:

%./Libero_SoC_<version>_lin.bin
7. When the installer Welcome page appears, follow the prompts to complete the installation.

1.4.2.2 Installing the Libero SoC Software in Console Mode (Full Product Installer)
Perform the following procedure to download and install the Libero SoC software suite with a full installer binary (11
GB).
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Important: Before installing the Libero SoC software, make sure your hard drive has at least 30 GB of
available space and at least 35 GB of available space in the temp directory during installation.

1. Visit www.microchip.com/en-us/products/fpgas-and-plds/fpga-and-soc-design-tools/fpga/libero-software-later-
versions#Documentation.

2. Download Libero_SoC_<version>_lin.zip installer to a temp directory.
3. Change directory to the temp directory.
4. Unzip(extract) the ZIP archive.
5. Launch the Libero SoC installer:

%./launch_installer.sh
6. When the installer Welcome page appears, follow the prompts to complete the installation

1.4.2.3 Installing the Service Pack
Service packs are incremental, and must be installed on top of previous releases. To verify your Libero SoC version,
from the Help menu, click About Libero.

IMPORTANT: <Libero_release>_Lin.tar.gz must be placed in the $ALSDIR/Libero directory and the installation must
take place on the local system.

1. Log in with read/write permission to the system on which Libero SoC is installed.
2. Download <Libero_release>_Lin.tar.gz into $ALSDIR/Libero. <Libero_release>_Lin.tar.gz

is now located at the same level as adm/, bin/, data/, and so on.
3. Type: tar xzvf <Libero_release>_Lin.tar.gz
4. Type: ./wsupdate.sh to complete the installation of the update.

1.4.3 Tips for Launching Libero on Linux Red Hat Operating Systems
For detailed instructions on how to launch Libero on Linux Red Hat operating systems, see the Libero SoC Linux
Environment Setup User Guide

1.5 Obtaining the Licenses
You must have a license to run the Libero SoC Software. Navigate to the following URL to learn about available
licenses, how to purchase new licenses or renew existing licenses, and how to obtain evaluation licenses:
www.microchip.com/en-us/products/fpgas-and-plds/fpga-and-soc-design-tools/fpga/licensing#overview

Do you need help with selecting a right license for your design? Use the Libero License Selector Guide, a license
selection tool that allows you to select the appropriate license option based on multiple parameters such as
FPGA/SoC device, Libero version, and operating system.

1.5.1 Libero License Options
Two license types are offered: node-locked or floating. A node-locked license is locked to a specific hard disk ID or
movable USB hardware key dongle. A USB dongle with the accompanying license file allows the software to operate
on any PC to which the dongle is attached and the license file and software are installed.

View the tool and device support for the various licenses at www.microchip.com/en-us/products/fpgas-and-plds/fpga-
and-soc-design-tools/fpga/licensing.

Node-locked license installation is covered in 1.6.  Installing Licenses.

Notes: 
• Node-locked licenses are supported on Windows platform and Floating license are supported on Windows,

Linux, and Solaris platforms.
• Remote access is not supported for node-locked Evaluation, Gold, Platinum, and Silver licenses. However, it

supports a standalone license.
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A floating license is typically installed on a network server (Windows, Linux, or Solaris) and allows networked client
PCs to access the license from the server. The Client PCs can be Windows or Linux OS. Client seats can be
purchased to allow up to 999 users to run the Libero software simultaneously.

Note: Node-locked and floating licenses do not support virtual machine servers.

Libero license manager and vendor daemons for all supported network server platforms are available at
www.microchip.com/en-us/products/fpgas-and-plds/fpga-and-soc-design-tools/fpga/licensing#downloads.

Note: To use 64-bit lmgrd, obtain it directly from Flexera. For information about installing a floating license, see
1.6.  Installing Licenses.

1.5.2 Obtaining Free Licenses
Microchip supports two types of free licenses: Evaluation and Silver.

For more information, visit www.microchip.com/en-us/products/fpgas-and-plds/fpga-and-soc-design-tools/fpga/
licensing.

1.5.2.1 How to obtain a Disk ID?
The DISK ID is the computer hard drive's serial number, also called Disk Serial Number. It is typically the c:\ drive
in your computer. The Disk ID is an 8 character hexadecimal number of the form, xxxx-xxxx, similar to "A085-AFE9".
The requested license is sent to you within 45 minutes. If you select a Node Locked License, the registration page
that requires the hard disk ID of the PC where the Libero SoC Software is installed. If you are not sure how to find the
hard disk ID, click the How to find a DiskID link to locate the ID and provide the Disk ID in the entry field.

To obtain your computer's Disk ID, type the following at a DOS or Command Prompt:

C:> Vol C:

Enter your C drive's Disk ID number into the license registration page window where indicated and click Submit.

1.5.2.1.1 How to Obtain a MAC ID?
If you select a floating license type, the registration window requires your MAC ID for your Windows or Linux PC, and
it requires the Host ID for your Solaris PC or Server.

Linux Node Locked or Floating

If you are not sure how to find the MAC ID, click the How to find a MAC ID link to locate the ID and provide the MAC
ID in the ID entry field. To obtain the MAC ID, type the following from the command prompt:

/sbin/ifconfig
The Ethernet/MAC ID address appears. The MAC ID address is a 12-character hexadecimal number, similar to
"00A0C982BEE3". Enter your MAC ID into the registration page window where indicated.

Windows Floating or Synplicity "Server-Based Node-Locked" (SBNL) Licenses

To obtain the PC MAC ID, type the following at a DOS or Command Prompt:

C:> lmutil lmhostid
You can also use:

C:> <path_to_actel_installation\bin\lmhostid>
The Ethernet/MAC ID address appears. The MAC ID address is a twelve character hexadecimal number, similar to
"00A0C982BEE3". Enter the 12-character MAC ID into the registration page window where indicated.

In some PC configurations, there can be more than one MAC ID. Use the MAC ID that will be the "active" ID. Some
users may configure their laptops to have the wired MAC ID for docked laptop use and the wireless MAC ID for
undocked use. Tools using the MAC ID depend on the MAC ID being active for use.

When finished, click Submit.

Print or write down the Software ID on the Registration Confirmation web page. Normally, the license is generated
and sent to your email address, typically in less than 45 minutes. The License.dat file is an attachment to the
email.

When the email and license arrive, follow the license installation instructions in 1.6.  Installing Licenses.
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1.5.3 Obtaining a Paid License
You can purchase the Libero Gold, Platinum, Standalone, and Archival licenses. Also, Microchip has Paid
DirectCores, Video SolutionCores, and MotorControl SolutionCores.

Visit www.microchip.com/en-us/products/fpgas-and-plds/fpga-and-soc-design-tools/fpga/licensing to see all available
license types.

Upon receipt of the purchase order, you will receive a SW ID document from Microchip through an email, which
contains the SW ID# number and the instructions to generate the required license.

For USB license type, you will be shipped USB dongle hardware and a software DVD, not the SW ID attached to
the DVD. The Software ID number for Libero licenses is in the format LXXX-XXXX-XXXX. The Software ID for Paid
DirectCores is in the format of CXXX-XXXX-XXXX. The Software ID for paid Video SolutionCores is in the format of
VXXX-XXXX-XXXX. The Software ID for paid MotorControl SolutionCores is in the format of MXXX-XXXX-XXXX Do
not generate the USB dongle license until you receive the USB dongle hardware from Microchip.

Note: The Libero SoC Software DVD is not available with node locked or floating licenses. It is available only with
USB node-locked licenses.

Note: Starting from 4/16/2019, Microchip discontinued USB Dongle license for Gold, Platinum, Gold Archival and
Platinum Archival licenses because Mentor has discontinued support for the USB dongle license. See PDN19017 for
discontinued Libero licenses.

Enter this Software ID number in the Register Purchased Product window, as shown in the following figure and click
Software ID for the Purchased Product.

Depending on the type of license you purchased, depending on the Software ID you provide, the web page will ask
you for a hard Disk ID, USB Dongle number or MAC ID.

If necessary, determine your DiskID or MAC ID number, enter it into the window, and click Submit.

1.5.3.1 How to Obtain a USB Dongle License?
If you select a USB Dongle license type, the registration window requires Flex ID available on the dongle key. The
following shows an example of a USB Dongle number.
Note: USB dongle license is supported on Libero Standalone license. It is not supported on Gold, Platinum, and its
Archival licenses. For more details, see PDN19017.

Note: The Flex ID information is available on the USB Dongle hardware shipped by Microchip.
Figure 1-1. Identifying the USB Dongle Hardware Key Number

The Registration Confirmation web page appears when you click Submit. Your license will be emailed to you,
typically within 45 minutes.

When the email and license arrive, follow the license installation instructions in Installing the Libero SoC Software.

1.5.4 Retrieving Copies of Existing Licenses
You can obtain the copies of licenses from the Microchip website and Customer Portal.

1. If you are the registered owner of a license, go to your Microchip Portal Account at www.microchipdirect.com/
register.

2. Click the Licenses & Registration link. A list of your software licenses, both current and expired, appears.
3. Click the link under Software ID of the desired license and click the Download License button to obtain a

copy

1.5.5 License Changes and Information
If you purchased a license, then some license changes can be performed.

• Change the owner of a license from one person to another. The new licensee must have a Microchip Portal
Account.

• Change the Disk ID for a license
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• Change the MAC ID for a license
• Change the USB Dongle ID for a license
• Additional email ids can be added to a license registration

The registered owner of a license will be notified 30 days, 15 days, and the last day in advance of the license
expiration date. An email will also be sent on the expiration date. There is no renewal for free license.

Consider purchasing an annual license after the evaluation period.

1.6 Installing Licenses
After you register for a license on the Microchip website, your license is automatically emailed to the address you
provided. A License.dat file is attached to the email.

Note: You must have Admin rights on the installation machine to install the Libero SoC Software and to set up
licensing.

1.6.1 Installing a Node Locked Disk ID License on Windows
1. Create a folder named flexlm on the c:\ drive and save the License.dat file in that folder.
2. Open your Environment Variables dialog box:

a. Right-click Computer and choose Properties to open the System dialog box.
b. Click Advanced System Settings to open the System Properties dialog box.
c. Click the Advanced tab.
d. Click the Environment Variables button.
e. In Windows Search, select Settings (Windows key +w) and search for Environment Variable.
f. Double-click the environment variable for your account to open the Editor.
g. Opens File Explorer, right-click This PC and select Properties.
h. Click Advanced System Settings and Click Environment Variables.

If LM_LICENSE_FILEis already listed in System variables, proceed to Step 3. If not, go to Step 5.
3. Select it, then click Edit.
4. Add the path to the Microchip License.dat file after any existing Variable value, separated with a semicolon

(no space), or replace the existing value.
Go to Step 10.

If LM_LICENSE_FILE is not listed in System VARIABLES:
5. Click New under System Variable to create a new system variable. The New System Variable dialog box

appears.
6. Type LM_LICENSE_FILE in the Variable name field.
7. Type c:\flexlm\License.dat in the Variable value field (or the path to where you installed the

License.dat file).
Note: Path to the installed license software is case sensitive; check for the case of the folder path in which the
license is saved.

8. Click OK.
9. Click OK to save new Environment Variables and return to System Properties.
10. Click OK to exit.

Installation is complete. Libero and all installed tools that require licenses are ready for use.
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Note: In addition to the LM_LICENSE_FILE variable, which applies to all vendors, Synopsys license can be set
using two vendor-specific variables:
Table 1-1. Variables to use with Synopsys License

Variable Description Variable Name Variable Value Example

SNPSLMD_LICENSE_FILE For Synopsys tools
released in September
2010 and later (2010.09)

SYNPLCTYD_LICENSE_FI
LE

c:\flexlm\License.da
t

SYNPLCTYD_LICENSE_FI
LE

For Synplify Pro releases
before September

SYNPLCTYD_LICENSE_FI
LE

c:\flexlm\License.da
t

1.6.2 Installing a Node-Locked USB Dongle License on Windows
1. Create a folder named flexlm under your c:\ drive.
2. Save the License.dat file in the flexlm folder. You can save the file in a different folder; if you do so, make

sure the correct path is defined in LM_LICENSE_FILE.
3. Open your Environment Variables dialog box:

a. Right-click Computer and choose Properties to open the System dialog box.
b. Click Advanced System Settings to open the System Properties dialog box.
c. Click the Advanced tab.
d. Click the Environment Variables button.
e. In Windows Search, select Settings (Windows key +w) and search for Environment Variable.
f. Double-click the environment variable for your account to open the Editor.
g. Open File Explorer, right-click This PC and select Properties.
h. Click Advanced System Settings and click Environment Variables.

If LM_LICENSE_FILE is already listed in System variables, proceed to Step 4. If not, go to Step 6.
4. Click New under System Variable to create a new system variable. The New System Variable dialog box

appears.
5. Type LM_LICENSE_FILE in the Variable name field.
6. Type c:\flexlm\License.dat in the Variable value field. Do not put spaces in the path.
7. Click OK. Proceed to Step 10.

If LM_LICENSE_FILE is already listed in System Variables:
8. Select the existing LM_LICENSE_FILE and click Edit.
9. Add the path to the Microchip License.dat file after any existing variable value (separated by a space) or

replace the existing value.
10. Click OK.
11. Click OK to save the new Environment Variables and return to System Properties.
12. Click OK to exit.
13. Attach the USB dongle hardware that was sent by Microchip to your PC.

1.6.2.1 Dongle Driver Version Update
The Libero SoC Installer does not install the FlexLM drivers for the USB dongle. If you use a dongle- based Libero
SoC license, you are responsible for installing the current version of the dongle driver.

Note: Before installing the USB drivers, Microchip recommends that you download and run the FlexLM Cleanup
Utility (3.9 MB) to remove any older, incompatible FlexLM drivers on your system.

To run the Libero SoC releases with a USB dongle license, update the dongle driver version to the current version.

1. Download the current dongle driver from www.microchip.com/en-us/products/fpgas-and-plds/fpga-and-soc-
design-tools/fpga/licensing#downloads.

2. When the download completes, run the Installer.exe file.
3. Follow the prompts to complete the installation.
4. Restart your system after installation for the dongle driver version to take effect.
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1.6.3 Installing a Floating License on a Windows Server
1. On the SERVER machine, save the License.dat file into a flexlm folder on your c:\ drive.
2. Download the required license manager daemons to your server platform from www.microchip.com/

en-us/products/fpgas-and-plds/fpga-and-soc-design-tools/fpga/licensing#downloads. Under Documents and
Downloads, click the Daemons Download tab and select the appropriate platform download. We recommend
placing these files into the same location as the License.dat file.

3. Open License.dat and edit the SERVER line by replacing <put.hostname.here> with your hostname. Do not
include the brackets. If necessary, change the port number (1702) to any unused port.

4. Libero floating licenses include Libero, Synplify Pro ME, Identify ME, Synphony Model Compiler ME, and
ModelSim ME tools. Edit each VENDOR and DAEMON line with the correct path to each vendor daemon and
then save the License.dat file. For example: VENDOR snpslmd C:\flexlm\snpslmd DAEMON mgcld
C:\flexlm\mgcld DAEMON actlmgrd C:\flexlm\actlmgrd

5. Log in to the SERVER machine and run the following command from the command prompt to start the lmgrd
License Manager on the server machine:

C:flexlm/lmgrd -c C:flexlm/License.dat
If you prefer to have the License Manager output written to a log file, run the following command at the command
prompt:

C:flexlm/lmgrd -c <path_to_License.dat>/License.dat -l <path_to_logfile>/license.log

1.6.4 Installing a Floating License on a Linux Server
1. On the SERVER machine, save the License.dat file.
2. Download the required license manager daemons to your server platform from www.microchip.com/

en-us/products/fpgas-and-plds/fpga-and-soc-design-tools/fpga/licensing#downloads. Under Documents and
Downloads, click the Daemons Download tab and select the appropriate platform download. We recommend
placing these files into the same location as the License.dat file.

3. Open License.dat using any editor. Edit the SERVER line by replacing <put.hostname.here> with your
machine Hostname. Do not include the brackets.

4. Libero Linux floating licenses include Libero, Synplify Pro ME, Identify ME, Synphony Model Compiler ME, and
ModelSim ME tools. Edit each VENDOR and DAEMON line with the correct path to each vendor daemon and
then save the License.dat file.

5. Login to the SERVER machine and run the following command to start the License Manager:
<path_to_lmgrd>/lmgrd -c <path_to_License.dat/License.dat>

f you prefer to have the License Manager output written to a log file, run the following command at the command
prompt:

<path_to_lmgrd>/bin/lmgrd -c <path_to_License.dat>/License.dat -l \ <path_to_logfile>/
license.log

1.6.5 Installing a Floating License on a Solaris Server
Libero SoC software does not run on Solaris. Solaris support is only provided for license server applications (License
Manager Only). The Solaris License Manager (lmgrd) serves Standalone Libero SoC floating licenses only.

1. On the SERVER machine, save the License.dat file.
2. Download the required license manager daemons to your server platform from www.microchip.com/

en-us/products/fpgas-and-plds/fpga-and-soc-design-tools/fpga/licensing#downloads. Under Documents and
Downloads, click the Daemons Download tab and select the appropriate platform download. We recommend
placing these files into the same location as the License.dat file.

3. Open License.dat using any editor. Edit the SERVER line by replacing <put.hostname.here> with your
machine Hostname. Do not include the brackets.

4. Standalone Libero SoC floating licenses include Libero SoC feature only.
5. Login to the SERVER machine and run the following command in a command terminal to start the license

manager: <path_to_lmgrd> /lmgrd -c <path_to_License.dat/License.dat>
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If you prefer to have the License Manager output written to a log file, run the following command at the command
prompt: :

<path_to_lmgrd>/lmgrd -c <path_to_License.dat>/License.dat -l 
<path_to_logfile>/license.log

1.6.6 Connecting the Client Machines (PCs and Linux) to the License Server
For Client machines where the FPGA design work will be done, Libero is available for Windows and Linux operating
systems.

1.6.6.1 Connecting the PC Client to a Windows or Linux License Server
From Control Panel > System > System Properties (Advanced tab) > Environment Variables, add or modify
LM_LICENSE_FILE to include port@hostname:

• Variable Name: LM_LICENSE_FILE Variable
• Value: port@hostname. Example: 1702@sage

For Synplify Pro, check out a license by adding or modifying one of the following two environment variables,
depending on the version of Synplify Pro used:

• SNPSLMD_LICENSE_FILE - For Synopsys tools released in September 2010 and later (2010.09).
– Variable Name: SNPSLMD_LICENSE_FILE
– Variable Value: <port@hostname> Example: 1702@sage

• SYNPLCTYD_LICENSE_FILE - For Synplify Pro releases before September
– Variable Name: SYNPLCTYD_LICENSE_FILE
– Variable Value: <port@hostname> Example: 1702@sage

1.6.6.2 Connecting the Linux Client to a Windows, Linux, or Solaris License Server
Use the following commands to set the environment variables on the Linux CLIENT machine:

setenv LM_LICENSE_FILE <port@hostname>

Example: setenv LM_LICENSE_FILE 1702@sage

For Synplify Pro, to check out a license, add or modify one of the following two environment variables, depending on
the version of Synplify Pro used:

• SNPSLMD_LICENSE_FILE - For Synopsys tools released in September 2010 and later (2010.09). setenv
SNPSLMD_LICENSE_FILE <port@hostname>Example: setenv SNPSLMD_LICENSE_FILE

1702@sage

• SYNPLCTYD_LICENSE_FILE - For Synplify Pro releases before September 2010. setenv
SYNPLCTYD_LICENSE_FILE <port@hostname> Example: setenv SYNPLCTYD_LICENSE_FILE
1702@sage

1.6.7 Installing a Server-Based Node-Locked License for Synphony Model Compiler ME
Prerequisite Software: To run Synphony Model Compiler ME, you must have MATLAB/Simulink by MathWorks
installed with a current license. You cannot run Synphony Model Compiler ME without MATLAB/Simulink.

Synphony Model Compiler ME licenses are included with Libero floating licenses: You do not need to install a
separate floating license for Synphony Model Compiler ME.

If you are using a Libero Node Locked license, then follow the instructions below
Note: Installation and setup of this license is different from other Microchip licenses. Install Synphony Model
Compiler ME software before installing this license file.

A Synphony Model Compiler ME license is a “floating” license. If your PC has a license manager running, turn off
the license manager before proceeding. Visit http://www.flexerasoftware.com/support.htm#acresso and consult the
FLEXnet Publisher Lmgrd and Utilities Manual for installation instructions.

1.6.7.1 Installing the IP Paid Licenses
After you receive the paid IP license from Microchip, append the text at the bottom of the original Libero license file.
For example, if you have a node locked paid IP license, add this text in Libero node locked license.
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1.7 Installation in Environments without a Consistent Internet Connection
If you prefer to disconnect from the Internet while using Libero, we encourage you to re-connect occasionally and
manually Check for SW Updates and Download New IP Cores to take advantage of new features, enhancements
and fixes.

Install the software as described in 1.4.  Installing the Libero SoC Software.

1.7.1 Change Your Vault Location
If you install the Libero SoC Software onto a network drive for multi-user access, you may want to specify a Vault
location that can be shared by all users.

Note: All users must have written permission to the shared vault location.

Microchip recommends a minimum disk space of 1.2 GB for the vault location. To change your Vault location:

1. Launch Libero SoC.
2. From the Project menu, choose Vault/Repositories Settings.
3. Click Vault location.
4. Enter a new Vault location in the text field.
5. Click OK.

To install Mega Vault,

Download and set-up of a complete Vault for new installations.
1. Using the link above, save the .zip file of the entire vault to your local machine. For example, c:\temp.
2. Unzip the file to a folder on your local machine (for example, c:\vault).

Set the path to the vault as follows:

For Libero PolarFire v2.1 and later (Windows only):

1. Complete the vault installation by running the setup.exe installer in the MegaVault zip file.
2. Click Project followed by Vault/Repositories Settings. The Vault/Repositories Setting dialog box appears.
3. Select Vault location from the options in the left pane.
4. Select a path for Vault installation folder.

1.7.1.1 Set the path to the vault as follows:
For Libero PolarFire v2.1 and later (Windows only):

1. Run the setup.exe installer (included in the MegaVault zip file) to complete vault installation.
2. Click Project followed by Vault/Repositories Settings. The Vault/Repositories Setting dialog box appears.
3. Select Vault location from the options in the left pane.
4. Select a path for Vault installation folder.

1.7.2 Disable Internet Options
You can disable Libero access to the Internet, or disable the automatic software update features. This is useful if your
Internet access is inconsistent. To do so:

1. In the Project menu choose Preferences to open the Preferences dialog box.
2. Click Software update and choose the Do not check for updates or remind me at startup radio button.
3. Click Internet Access and uncheck Allow Access to Internet.
4. Click OK to continue.

1.7.3 Download Direct Cores and SgCore (SmartDebug) Cores to Populate your Vault
When you maintain a constant Internet connection, you are prompted for download of Cores required for your Libero
project. If you plan to disconnect from the Internet, you must populate your vault after initial Libero SoC installation
and before you disconnect from the Internet. To do so:

1. Launch the Libero SoC Software.
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2. From the View menu, choose Windows > Catalog to open the Catalog.
3. Click Download them now. The download may take several minutes, depending on your Internet speed. The

completion percentage is tracked in the progress bar.

The Download them now button disappears when the download is complete. The new cores are now available in
your Catalog.

You may also download the Direct Cores and Sgcores at http://www.actel-ip.com/cwps/download_index/DirectCore
and http://www.actel-ip.com/cwps/download_index/SgCore.

1.7.4 Download Firmware Cores
You can download Firmware Cores and store them in the same vault location as the DirectCore and Sg
(SmartDesign) cores:

1. Access the Microchip Firmware Catalog.
2. Download the Firmware Catalog.

After the initial setup is completed following the steps above, an Internet connection is no longer required for Libero
operation. However, most documentation and silicon user’s guides are available only from the Microchip website.

Attention: Some links in the Libero log windows require an Internet connection.

 Libero® SoC v2022.2
Libero SoC Software Installation and Configuration

© 2022 Microchip Technology Inc.
and its subsidiaries

 User Guide DS00003751B-page 13

http://www.actel-ip.com/cwps/download_index/DirectCore
http://www.actel-ip.com/cwps/download_index/SgCore
https://www.microchip.com/en-us/products/fpgas-and-plds/fpga-and-soc-design-tools/soc-fpga/firmware-catalog


2. References
• See the licensing information at www.microchip.com/en-us/products/fpgas-and-plds/fpga-and-soc-design-tools/

fpga/licensing.
• View IP information at http://www.microsemi.com/products/fpga-soc/design-resources/ip-cores/direct-cores.
• View the tool and device support for the various licenses at, www.microchip.com/en-us/products/fpgas-and-plds/

fpga-and-soc-design-tools/fpga/licensing.
• See the Libero License Selector Guide for more information about license offerings.
• Sign up to receive notifications about discontinued operating system support.
• See the Licensing page to view Libero SoC Software license offerings and changes.
• See www.microsemi.com/product-directory/design-resources/5092-ip-cores for Direct Core licenses.
• See www.microsemi.com/product-directory/technology/3861-imaging#imaging-software-and-ip for Video Cores

licenses.
• See www.microchip.com/technology/motor-control#ip-suite for Motor Control licenses.
• See the Licensing page for discontinued Libero licenses.
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3. Revision History
The revision history describes the changes that were implemented in the document. The changes are listed by
revision, starting with the most current publication.

Revision Date Description

B 08/2022 Performed the following changes:
• Revised the guide to reflect the procedures for installing Libero

v2022.2.
• Changed the path of the shell script in section 1.1.  System

Requirements.
• Added note that the Synopsys license can be set using two vendor-

specific variables in section 1.6.1.  Installing a Node Locked Disk ID
License on Windows.

A 12/2020 Initial Revision
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Microchip Information

The Microchip Website
Microchip provides online support via our website at www.microchip.com/. This website is used to make files and
information easily available to customers. Some of the content available includes:

• Product Support – Data sheets and errata, application notes and sample programs, design resources, user’s
guides and hardware support documents, latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical support requests, online
discussion groups, Microchip design partner program member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip press releases, listing of
seminars and events, listings of Microchip sales offices, distributors and factory representatives

Product Change Notification Service
Microchip’s product change notification service helps keep customers current on Microchip products. Subscribers will
receive email notification whenever there are changes, updates, revisions or errata related to a specified product
family or development tool of interest.

To register, go to www.microchip.com/pcn and follow the registration instructions.

Customer Support
Users of Microchip products can receive assistance through several channels:

• Distributor or Representative
• Local Sales Office
• Embedded Solutions Engineer (ESE)
• Technical Support

Customers should contact their distributor, representative or ESE for support. Local sales offices are also available to
help customers. A listing of sales offices and locations is included in this document.

Technical support is available through the website at: www.microchip.com/support

Microchip Devices Code Protection Feature
Note the following details of the code protection feature on Microchip products:

• Microchip products meet the specifications contained in their particular Microchip Data Sheet.
• Microchip believes that its family of products is secure when used in the intended manner, within operating

specifications, and under normal conditions.
• Microchip values and aggressively protects its intellectual property rights. Attempts to breach the code

protection features of Microchip product is strictly prohibited and may violate the Digital Millennium Copyright
Act.

• Neither Microchip nor any other semiconductor manufacturer can guarantee the security of its code. Code
protection does not mean that we are guaranteeing the product is “unbreakable”. Code protection is constantly
evolving. Microchip is committed to continuously improving the code protection features of our products.

Legal Notice
This publication and the information herein may be used only with Microchip products, including to design, test,
and integrate Microchip products with your application. Use of this information in any other manner violates these
terms. Information regarding device applications is provided only for your convenience and may be superseded
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by updates. It is your responsibility to ensure that your application meets with your specifications. Contact your
local Microchip sales office for additional support or, obtain additional support at www.microchip.com/en-us/support/
design-help/client-support-services.

THIS INFORMATION IS PROVIDED BY MICROCHIP "AS IS". MICROCHIP MAKES NO REPRESENTATIONS
OR WARRANTIES OF ANY KIND WHETHER EXPRESS OR IMPLIED, WRITTEN OR ORAL, STATUTORY
OR OTHERWISE, RELATED TO THE INFORMATION INCLUDING BUT NOT LIMITED TO ANY IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY, AND FITNESS FOR A PARTICULAR PURPOSE,
OR WARRANTIES RELATED TO ITS CONDITION, QUALITY, OR PERFORMANCE.

IN NO EVENT WILL MICROCHIP BE LIABLE FOR ANY INDIRECT, SPECIAL, PUNITIVE, INCIDENTAL, OR
CONSEQUENTIAL LOSS, DAMAGE, COST, OR EXPENSE OF ANY KIND WHATSOEVER RELATED TO THE
INFORMATION OR ITS USE, HOWEVER CAUSED, EVEN IF MICROCHIP HAS BEEN ADVISED OF THE
POSSIBILITY OR THE DAMAGES ARE FORESEEABLE. TO THE FULLEST EXTENT ALLOWED BY LAW,
MICROCHIP'S TOTAL LIABILITY ON ALL CLAIMS IN ANY WAY RELATED TO THE INFORMATION OR ITS USE
WILL NOT EXCEED THE AMOUNT OF FEES, IF ANY, THAT YOU HAVE PAID DIRECTLY TO MICROCHIP FOR
THE INFORMATION.

Use of Microchip devices in life support and/or safety applications is entirely at the buyer's risk, and the buyer agrees
to defend, indemnify and hold harmless Microchip from any and all damages, claims, suits, or expenses resulting
from such use. No licenses are conveyed, implicitly or otherwise, under any Microchip intellectual property rights
unless otherwise stated.

Trademarks

The Microchip name and logo, the Microchip logo, Adaptec, AVR, AVR logo, AVR Freaks, BesTime, BitCloud,
CryptoMemory, CryptoRF, dsPIC, flexPWR, HELDO, IGLOO, JukeBlox, KeeLoq, Kleer, LANCheck, LinkMD,
maXStylus, maXTouch, MediaLB, megaAVR, Microsemi, Microsemi logo, MOST, MOST logo, MPLAB, OptoLyzer,
PIC, picoPower, PICSTART, PIC32 logo, PolarFire, Prochip Designer, QTouch, SAM-BA, SenGenuity, SpyNIC, SST,
SST Logo, SuperFlash, Symmetricom, SyncServer, Tachyon, TimeSource, tinyAVR, UNI/O, Vectron, and XMEGA are
registered trademarks of Microchip Technology Incorporated in the U.S.A. and other countries.

AgileSwitch, APT, ClockWorks, The Embedded Control Solutions Company, EtherSynch, Flashtec, Hyper Speed
Control, HyperLight Load, Libero, motorBench, mTouch, Powermite 3, Precision Edge, ProASIC, ProASIC Plus,
ProASIC Plus logo, Quiet- Wire, SmartFusion, SyncWorld, Temux, TimeCesium, TimeHub, TimePictra, TimeProvider,
TrueTime, and ZL are registered trademarks of Microchip Technology Incorporated in the U.S.A.

Adjacent Key Suppression, AKS, Analog-for-the-Digital Age, Any Capacitor, AnyIn, AnyOut, Augmented Switching,
BlueSky, BodyCom, Clockstudio, CodeGuard, CryptoAuthentication, CryptoAutomotive, CryptoCompanion,
CryptoController, dsPICDEM, dsPICDEM.net, Dynamic Average Matching, DAM, ECAN, Espresso T1S,
EtherGREEN, GridTime, IdealBridge, In-Circuit Serial Programming, ICSP, INICnet, Intelligent Paralleling, IntelliMOS,
Inter-Chip Connectivity, JitterBlocker, Knob-on-Display, KoD, maxCrypto, maxView, memBrain, Mindi, MiWi, MPASM,
MPF, MPLAB Certified logo, MPLIB, MPLINK, MultiTRAK, NetDetach, Omniscient Code Generation, PICDEM,
PICDEM.net, PICkit, PICtail, PowerSmart, PureSilicon, QMatrix, REAL ICE, Ripple Blocker, RTAX, RTG4, SAM-
ICE, Serial Quad I/O, simpleMAP, SimpliPHY, SmartBuffer, SmartHLS, SMART-I.S., storClad, SQI, SuperSwitcher,
SuperSwitcher II, Switchtec, SynchroPHY, Total Endurance, Trusted Time, TSHARC, USBCheck, VariSense,
VectorBlox, VeriPHY, ViewSpan, WiperLock, XpressConnect, and ZENA are trademarks of Microchip Technology
Incorporated in the U.S.A. and other countries.

SQTP is a service mark of Microchip Technology Incorporated in the U.S.A.

The Adaptec logo, Frequency on Demand, Silicon Storage Technology, and Symmcom are registered trademarks of
Microchip Technology Inc. in other countries.

GestIC is a registered trademark of Microchip Technology Germany II GmbH & Co. KG, a subsidiary of Microchip
Technology Inc., in other countries.

All other trademarks mentioned herein are property of their respective companies.
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Quality Management System
For information regarding Microchip’s Quality Management Systems, please visit www.microchip.com/quality.
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